
Meaningful Use and  
TRAKnet™ PM 



ARRA Incentive Program 

• The first step toward obtaining your ARRA incentive is to 
register.  Information on registering can be found here:  
 
http://www.cms.gov/EHRIncentivePrograms/20_RegistrationandAttestation.asp#BOOKMARK1 

 
• You must submit the TRAKnet™ PM Edition 15-digit CMS 

EHR Certification ID number when you register.  
– TRAKnet™ PM CMS EHR Certification ID: 30000001SVTVEAK 

  
• In order to qualify for the first ARRA reimbursement 

payment you must show 90 DAYS OF CONSECUTIVE 
MEANINGFUL USE IN 2011.  



Meaningful Use Objectives 

• 15 Core Set Objectives 
– Eligible Providers (EP) must meet all 15 required 

objectives.  

• 10 Menu Set Objectives 
– Eligible Providers must choose and meet 5 of the 

required objectives.  



15 Core Set Objectives 

• EPs must meet and attest to all 15 Core 
Objectives. 



1. Use Computerized Physician  Order 
Entry (CPOE) 

• Measure = Greater than 30% of unique patients who have at least 
one medication in their meds list need to have at least one 
medication order entered through CPOE. 

• TRAKnet™ PM Steps  
– Select a patient that has at least one medication in their meds list. 
– Add encounter. 
– Select “Orders” tab. 
– Select “Prescriptions”, click “Add” button. 
– Write script (print or send electronically). 



2.  Implement Drug-Drug, Drug-
 Allergy & Drug-Formulary Checks 

• Measure = The EP (Eligible Provider) needs to have this feature set 
enabled during the entire reporting period. For year 1, that would 
be for 90 days, and the entire year in reporting years 2–5. 

• TRAKnet™ PM Steps 
– EP must have signed up for SureScripts, which is included in TRAKnet™ PM at 

no additional cost.  



3. Generate and Transmit Permissible 
Prescriptions Electronically (eRx) 

• More than 40% of all permissible prescriptions written by the EP 
are transmitted electronically using certified EHR technology. 

• TRAKnet™ PM Steps 
– Add prescription. 
– Send electronically to SureScripts. 



4. Record Demographics:  
 Preferred  Language, Gender, Race, Ethnicity  
      & DOB 

• Measure = More than 50% of all unique patients seen by the EP or 
admitted to the eligible hospital or CAH have demographics as 
recorded structured data.  

• TRAKnet™ PM Steps 
– Record the following demographics in the patient’s chart: 

• Preferred Language 
• Gender 
• Race 
• Ethnicity 
• Date of Birth 

– Patient must have an encounter during reporting period.  
 



5. Maintain Up-to-Date Problem List of 
 Current and Active Diagnoses  

• Measure = More than 80% of all unique patients seen by the EP 
have at least one entry or an indication that no problems are known 
for the patient recorded as structured data.  

• TRAKnet™ PM Steps 
– Add a Diagnoses for a patient. 
– OR… Select “Diagnoses” in their chart, click “Add” Button and select “Patient 

has no diagnoses.” 
– Patient must have an encounter during the reporting period.  



6. Maintain Active Medication List  

• Measure = More than 80% of all unique patents seen by the EP 
have at least one entry (or an indication that the patient is not 
currently prescribed any medication) recorded as structured data.  

• TRAKnet™ PM Steps 
– Add medication history for a patient. 
– OR… Select “Meds” from the history portion of their chart, click “Add” and 

select “No Medications”. 
– Patient must have an encounter during the reporting period.  

 



7. Maintain an Active Medication 
 Allergy List 

• Measure = Maintain active medication allergy list.  
• TRAKnet™ PM Steps 

– Patient’s Chart > Charting > History > Allergies >  Click “Add” Button.  
– Select specific allergies or select the “No known allergies” checkbox. 
– Patient must have an encounter during the reporting period.  



8. Record and Chart Vital Signs:  
 Height, Weight, Blood Pressure, Calculate and Display BMI, 
 Plot and Display Growth Charts for Children 2-20 Years, 
 Including BMI  

• Measure = For more than 50% of all unique patients age 2 and over 
seen by the EP, height, weight, and blood pressure are recorded as 
structured data. 

• TRAKnet™ PM Steps 
– Select “Vitals” from the patients chart. Click “Add” button.  
– Patient must have an encounter during the reporting period.  

 



9. Record Smoking Status 

• Measure = More than 50% of all unique patients 13 years or older 
seen by the EP have smoking status recorded as structured data.  

• TRAKnet™ PM Steps 
– Patient’s Chart > Charting > Quality Measures. Click “Add”. Select “Smoking 

Status” and click “Save”.  
– Patient must have an encounter during the reporting period.  

 



10. Report Clinical Quality Measures to 
  CMS or the States  

• Measure = For 2011, provide aggregate numerator, denominator 
and exclusions through attestation; For 2012, electronically submit 
clinical quality measures. 

• TRAKnet™ PM Steps 
– EP must run the Quality Measures report and use the data when attesting to 

CMS or their specific state.  



11. Implement One Clinical Decision   
  Support Rule 

• Measure = Implement one clinical decision support rule and have 
the ability to track compliance.    

• TRAKnet™ PM Steps 
– Only have to setup one CDR. 
– Desktop > Tools > Patient Queries. Select “Clinical Decision Rules”. Click “Add”. 

Fill in appropriate demographic and other conditions of the rule. Click “Save.”  



12. Provide Patients with an Electronic 
  Copy of their Health Information 
  

• Measure = More than 50% of all unique patients of the EP, who 
request an electronic copy of their health information are provided 
it within 3 business days, including diagnostic test results, problem 
list, medication lists, medication allergies, discharge summary and 
procedures. 

• TRAKnet™ PM Steps 
– Patient’s Chart > File > Export > CCD > For Patient. 



13. Provide Clinical Summaries for  
  Each Office Visit  

• Measure = Clinical summaries provided to patients for more than 
50% of all office visits within 3 business days.  

• TRAKnet™ PM Steps 
– Percentage of all the encounters, within the reporting period, where a CCD 

was exported for the patient. 
– Encounter > File Export > CCD > For Patient. 



14. Exchange Key Clinical Information  
       Electronically  
  
• Measure = Performed at least one test of the certified EHR 

technology’s capacity to electronically exchange key clinical 
information. Ex: problem list, medication list, medication allergies, 
diagnostic test results. 

• TRAKnet™ PM Steps 
– Practice will need to sign up for Microsoft® HealthVault; to learn how please click here.  
– Patient must give TRAKnet™ permission to upload CCDs. 
– From patient’s chart click: File > Export > Continuity of Care Document (CCD) > For HealthVault… 
– Practice must save the file in shared CCD export folder (stored in the TRAKnet™ export folder on 

server). 
– Start-up service must be installed on practice’s server by BioMedix™ Customer Service. 
– Service will run the upload process upon start-up and every 24 hours afterwards. 
– CCD must be uploaded to HealthVault to meet this requirement.  

http://biomedix.com/userfiles/file/TRAKnetDPM/HealthVaultRevAJun.pdf


15. Protect Electronic Health     
       Information 
• Protect Electronic Health Information created or maintained by 

certified EHR technology through the implementation of 
appropriate technical capabilities. 

• Measure = Conduct or review a security risk analysis per 45 CFR 
164.308(a)(1) and implement updates as necessary and correct 
identified security deficiencies as part of the EP’s risk management 
process.  

• TRAKnet™ PM Steps 
– This must be done manually and outside of TRAKnet™ PM. However, 

TRAKnet™ PM provides access control, authentication, automatic log-off, audit 
log, integrity and encryption of data at rest and in motion to ensure that 
protected health information remains safe and secure. 



10 Menu Set Objectives 

• EPs must choose 5 of the 10 Menu Set 
Objectives.  



1. Implement Drug-Formulary Check  
 

• Measure = The EP has enabled this functionality and has access to 
at least one internal or external drug formulary for the entire EHR 
reporting period. 

• TRAKnet™ PM Steps 
– EP must be signed up for SureScripts. 

 



2. Incorporate Clinical Lab-Test Results 
 into Certified EHR Technology 
 
• Measure = More than 40% of all clinical lab test results ordered by 

the EP for patients admitted during the EHR reporting period whose 
results are either in a positive/negative or numerical format are 
incorporated in certified EHR technology as structured data.  

• TRAKnet™ PM Steps 
– Patient’s Chart >Charting > Labs > Click “Add” Button. Select Lab Test, Enter in 

Vendor (note must set up vendors from the desktop), Enter in a value in the 
“Result” field. 

– Patient must have an encounter during the reporting period.  



3. Generate Lists of Patients by Specific 
 Conditions  
  
• Measure = Generate at least one report listing patients of the EP, 

eligible hospital or CAH with a specific condition for use in quality 
improvement, reduction of disparities, research or outreach. 

• TRAKnet™ PM Steps 
– Desktop > Tools > Patient Queries > Click “Add” Button. Select “Patient Lists” 

from the “Report Type” dropdown. Fill in information. Click “Save”.  
– Only need to have created one patient list to satisfy the requirement.  

 



4. Send Reminders to Patients for 
 Preventive/Follow-up Care 

• Measure = More than20% of all unique patients 65 years or older or 
5 years old or younger were sent an appropriate reminder during 
the EHR reporting period. 

• TRAKnet™ PM Steps  
– Add an appointment. 
– Desktop > File > Export > Appointments (ReminderPro). Select date range to 

include the appointment. Click “OK.”  
 



5. Provide Patients with Timely 
Electronic Access to their Health 
Information 
  • Measure = More than 10% of all unique patients seen by the EP are 

provided timely (available to the patient within 4 business days of 
being updated in the certified EHR technology) electronic access to 
their health information(including lab results, problem list, 
medication lists, medication allergies) subject to the EP’s discretion 
to withhold certain information. 

• TRAKnet™ PM Steps 
– Patient’s Chart > File > Export > CCD > For HealthVault. 
– When you export the CCD you are creating the denominator for the measure. 

The numerator is calculated by a background service that runs on their 
machine that sends the CCD to Microsoft HealthVault. This service runs daily, 
so it should always be 100%. 

 



6. Use Certified EHR Technology to 
Identify Patient-Specific Education 
Resources 
 

• Measure = More than 10% of all unique patients seen by the EP or 
admitted to the eligible hospital or CAH are provided patient-
specific education resources. 

• TRAKnet™ PM Steps 
– Setup Patient Education. Desktop > Medical Content > Education. Click “Add”. 

Select Type, e.g. “Diagnoses”. Enter Diagnosis, e.g. 250.00. Enter in URL, e.g. 
http://diabetes.webmd.com OR a file path to a document on the local 
machine or network.  

– Patient’s Chart > Diagnoses > Click “Add” button. Add Diagnoses, e.g. 250.00.  
– Patient’s Chart > Tools > Patient Education. Must print the education to satisfy 

requirement.  
 

http://diabetes.webmd.com/


7. Medication Reconciliation 
 
 
• The EP who receives a patient from another setting of care or 

provider of care or believes an encounter is relevant should 
perform medication reconciliation. 

• Measure = The EP performs medication reconciliation for more 
than 50% of transitions of care in which the patient is transitioned 
into the care of the EP. 

• TRAKnet™ PM Steps 
– Patient’s Chart > Referrals > Click “Add”. Select Referring Provider. Set “Order 

Type” to “Incoming”. Set “Medication Reconciliation” to “True”. 
 



8. Provide a Summary of Care Record 
 for Each Transition of Care or 
 Referral  
  • The EP who receives a patient from another setting of care or 

provider of care or refers their patient to another provider of care 
should provide a summary of care record for each transition of care 
or referral. 

• Measure = The EP who transitions or refers their patient to another 
setting of care or provider of care provides a summary of care 
record for more than 50% of transitions of care and referrals.  

• TRAKnet™ PM Steps 
– Patient’s Chart > Referrals > Click “Add” button. Select referring provider. 

Under “Referring Provider” section > CCD Received > click in the box and 
browse for a CCD (*Note, must have a CCD to receive. This can be created by 
exporting prior to doing this for testing purposes). Click “Save”. 

 



9. Submit Electronic Data to 
 Immunization Registries or 
 Immunization  Information Systems 
  
• Measure = Performed at least one test of the certified EHR 

technology’s capacity to submit electronic data to immunization 
registries and follow-up submission if the test is successful (unless 
none of the immunization registries to which the EP submits such 
information have the capacity to receive such information 
electronically). 

• TRAKnet™ PM Steps 
– Desktop > File > Export > Immunizations (HL7). 

• Note: You must have at least one patient w/ an immunization in their 
chart. 

 



10. Submit Electronic Syndromic  
      Surveillance Data to Public Health  
      Agencies 

• Measure = Performed at least one test of certified EHR technology’s 
capacity to provide electronic syndromic surveillance data to public 
health agencies and follow-up submission if the test is successful 
(unless none of the public health agencies to which the EP submits 
such information have the capacity to receive such information 
electronically).  

• TRAKnet™ PM Steps 
– Desktop > File > Export > Electronic Syndromic Surveillance (HL7).  

• Note: Must have a patient with any 487.XX diagnosis code in their 
problem list. 

• Note: Must also have a valid “County” entered into your location. 
 



Thank You 
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